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Introduction 
 
Bienvenue dans Amberlight! 
 
Amberlight est un outil artistique unique qui créé de magnifiques images générées par 
ordinateur. Des millions de particules volent sur votre canvas et vous pouvez les guider avec les 
camps spéciaux Amber. Que vous soyez un artiste avancé ou un débutant, en jouant et 
expérimentant avec ses outils, vous pourrez créer des images fantastiques. Dans le monde de 
l’art par ordinateur, c’est un outil unique en son genre qui élargira vos horizons artistique set 
vous délivrera une toute nouvelle expérience artistique. 
 
Similairement à Flame Painter, Amberlight a été originellement créé comme un projet 
expérimental dans ma série 'I am an Artist' (« je suis un artiste »). La vision initiale était de 
créer une application où n’importe qui puisse créer sa propre pièce d’art. Elle a été conçue 
comme un outil pour les artistes autant que pour les gens sans talent artistique particulier 
désirant créer quelque chose d’unique.  
Le manque d’inspiration et de motivation sont souvent les raisons pour lesquelles les gens ne 
sont pas créatifs, néanmoins, les outils que nous utilisons peuvent devenir une source 
d’inspiration. Je pense qu’avec des outils qui vous inspirent, tout le monde peut être un artiste.  
Ce manuel explique les possibilités du logiciel et vous explique ce que vous devez savoir pour 
utiliser Amberlight et trouver une toute nouvelle voie d’expression. 
 
Merci d’avoir acheté Amberlight. J’espère que vous prendrez beaucoup de plaisir ! 
 
 
         Peter Blaškovič 
         Créateur d'Amberlight 
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Comment démarrer 
 

Installation et enregistrement de Amberlight 
 

Téléchargement et installation 
 
Après avoir acheté Amberlight sur notre site Internet, vous recevrez un mail contenant un lien 
de téléchargement et les informations sur l'enregistrement du logiciel.  
 
Utilisateurs Mac OS X 
Téléchargez un fichier .dmg à partir du lien spécifié dans votre mail. Identifiez le fichier 
d'installation " Amberlight 2.1.dmg ”. Double-cliquez sur cet installeur pour terminer 
l'installation. 
 
Utilisateurs Windows 
Téléchargez un fichier .zip à partir du lien spécifié dans votre mail. Identifiez le conteneur 
d'installation nommé "Amberlight 2.1.zip”. Décompactez ce fichier dans un répertoire et 
double cliquez sur l'installeur .exe pour lancer l'installation. 
 
 
Enregistrement 
 
Remplissez le formulaire d'enregistrement avec les informations données dans le mail. Vérifiez 
que vous êtes bien connecté à Internet, car une connexion est nécessaire lors de l'activation, 
pour vérifier ces informations. 
  
Astuce : Nous vous recommandons de copier & coller votre clef d'enregistrement et votre ID 
pour éviter toute faute de frappe. 
 
 
Lancement de l'application  
 
Un tutoriel est affiché lors du premier lancement de l'application, ainsi qu'après chaque mise à 
jour. Ce tutoriel vous guidera au travers des fonctions les plus importantes d'Amberlight. Vous 
pouvez le visualiser à tout moment, en cliquant sur le menu Aide -> Mode d'utilisation. 
 
 
Ressources système nécessaires 
 
Ordinateur équipé d'un processeur Intel ou AMD, une carte graphique supportant OpenGL 2.0, 
1Go de mémoire vive, 40 Mo d'espace disque, Windows XP, Vista, 7, 8, 10, ou Mac OS X 10.6 
ou plus récent. 
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Comment obtenir de l'aide pour Amberlight 
 
Si vous avez besoin d'aide pour utiliser Amberlight, consultez le présent manuel. Nous avons 
essayé de le rendre simple et d'y mettre toutes les informations dont vous avez besoin.  
 
N'hésitez pas à nous envoyer un mail à  support@escapemotions.com si vous avez une 
question, rencontré un problème ou que vous souhaitez simplement nous dire bonjour.  
 
Avant de nous poser une question, n'oubliez pas de consulter la FAQ (Foire Aux Questions) 
dans la partie Support de notre site Internet http://amberlight.escapemotions.com. 
Si vous ne trouvez pas la solution à votre problème, ne manquez pas d'indiquer la configuration 
de votre ordinateur (Windows / Mac OS, 32 / 64bit OS, processeur, carte graphique, mémoire) 
dans le mail. Cela nous aidera à vous répondre plus rapidement. 
 
 
Communauté 
 
Restez en contact grâce aux réseaux sociaux - Cliquez sur n'importe quelle icône et visitez nos 

pages sur Facebook, Twitter, Pinterest, Google+, Tumblr, YouTube, DeviantArt, Behance et 

Instagram.  

 

0 

 

 

  

mailto:support@escapemotions.com
https://www.instagram.com/escapemotions
https://www.facebook.com/flamepainterpage?ref=hl
https://www.behance.net/escapemotions
http://escmot.deviantart.com/
https://www.youtube.com/user/EscapeMotions
https://www.tumblr.com/blog/escapemotions
https://plus.google.com/u/1/b/109066869359827919028/109066869359827919028/posts
http://www.pinterest.com/escapemotions/
https://twitter.com/escapemotions
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Interface Utilisateur 
 

 
 

1 - Fenêtre de visualisation 
2 - Fenêtre Scène 
3 - Fenêtre Paramètres 
4 - Fenêtre des modificateurs 
5 - Fenêtre de la courbe de contraste 
6 - Fenêtre des filtres 
7 - Fenêtre de navigation 
8 - Fenêtre des palettes 
9 - Fenêtre des calques 
10 - Fenêtre Base de temps 
 
Cette présentation est celle par défaut d'Amberlight. Vous pouvez la personnaliser en fonction 
de votre façon de travailler. 
 
Astuce : Toutes les fenêtres sont personnalisables : vous pouvez les modifier, les déplacer et 
changer leurs tailles. 
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Fenêtre Scène 
 

Fields (Champs) - Définit le nombre de champs (1-12). 

 /   - Ajoute ou supprime des champs. 

 Edit (Edition) - Bascule dans le mode d'édition des 
champs. 

 Random fields (Champs aléatoires) - Définition 
aléatoire de la scène et des champs. 
 

 Render (Générateur) - Génération de l'image en cours. 

 Render animation (Générateur d'animation) - 
Génération de la prévisualisation de l'animation. 
Step (Pas) - Définition du nombre de pas - si vous 
souhaitez une scène très précise, choisissez 10000. Si 
vous souhaitez une qualité d'impression, prenez une 
valeur plus élevée. 

 Use actual value (Utiliser la valeur actuelle) - Utilisez 
la valeur actuelle de l'itération comme valeur finale. 
Raster (Pixellisation) - Valeur de pixellisation (1-8). 
Définissez une valeur élevée pour une prévisualisation de 
la scène, le temps de calcul sera plus court. 

 
 

 

Fenêtre Paramètres 
 

Cette fenêtre est associée au champ sélectionné 
Position X - Définit l'abscisse du champ. 
Position Y - Définit l'ordonnée du champ. 
Force - Définit la force du champ. 
Intensity (Intensité) - Définit l'intensité du champ. 
Cut-off - Définit la valeur de coupure du champ. 
 
Vous trouverez plus d'information sur les paramètres des 
champs et comment les utiliser dans le chapitre 'Error! R
eference source not found.’. 
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Fenêtre des modificateurs 
 
Essayez en modifiant les différentes valeurs et en observant le rendu final. Les modificateurs 
comprennent :  
 

Variations 

 
Vous pouvez choisir entre deux types de variations :  
 
Random (Aléatoire) - Les champs créeront des formes et 
des groupes aléatoires. 
Uniform (Uniforme) - Les champs créeront de formes et 
des groupes uniformes. 
 
Number (Nombre) - Choisissez le nombre de variations (1-
50). Cette valeur influe sur le nombre de variations qui 
seront crées dans l'image. 
 
Scale (Echelle) - Echelle des (1-100). Cette valeur affecte la 
position de chaque variation. Quand elle est faible, les 
variations seront proches les unes des autres. Quand elle 
est élevée, les variations seront plus espacées.   
 

Wave (Onde) 
 
Wave est un modificateur influant sur l'aspect final. Il 
existe six types de modificateurs d'onde : 
 
None (Aucun) - Pas de modification. 
Circle (Cercle) - Onde circulaire. 
Square (Carré) - Onde carrée. 
Vertical - Onde verticale. 
Horizontal - Onde horizontale. 
 
Frequency (Fréquence) - Définit la fréquence à la quelle 
les ondes seront répétées dans l'image (1-100). 
 
Amplitude - Définit l'amplitude des ondes (1-100). 
L'amplitude est égale à la moitié de la distance entre les 
valeurs minimale et maximale de l'onde. 
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Fenêtre de la courbe de contraste 
 

Il existe trois réglages pour le contraste : 
 
Base - Règle la base de la courbe de contraste - ombre. 
Peak (Pic) - Règle les pics de la courbe - surbrillance. 
Limite - Règle la limite de pic de la courbe. 
 

 

 

Fenêtre des filtres 
 

Vous pouvez utiliser les paramètres suivants : 
 
Alpha Mask (Masque alpha) - Opacité de l'image (0 - 
100). 
Tint (Teinte) - Activer/désactiver le dégradé et régler la 
couleur, l’orientation et le rayon (0 - 100). 
Glow (Brillance) - Activer/désactiver l’effet de brillance. 
Radius (Rayon) - Règle le rayon de la brillance (0 - 100). 
Strength (Force) - Règle la force de la brillance (0 - 100). 

 

Fenêtre de navigation 
 

 Zoom Arrière - Pour réduire l'affichage (minimum 5%). 

 Zoom Avant - Pour agrandir l'affichage (maximum 
2000%). 
Curseur Zoom - Définit le rapport de zoom (1 - 2000%). 

 Réinitialisation du zoom - Pour vérifier le rapport du 
zoom. Pressez le bouton pour avoir un affichage à 100%. 

 Ajuster à l'écran - L'image remplit la Fenêtre de 
visualisation. 
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Fenêtre des palettes 
 

Sélectionnez et réglez votre dégradé pour l'image. Cliquez 
sur la couleur que vous souhaitez modifier puis choisissez 
une couleur dans la palette. Vous pouvez activer ou 
désactiver la couleur que vous souhaitez utiliser dans le 
dégradé. 
 

 Ouverture de la palette de couleurs système. 

 Dégradé de la couleur sélectionnée vers le blanc. 

 Dégradé de la couleur sélectionnée vers le noir. 
 

 Flip (Basculer) - Bascule du dégradé. 

 Invert (Inverser) - Inversion des couleurs. 

 Shift -Décalage des couleurs du dégradé vers la droite. 
 
H | S | L - Modification de la teinte, de la saturation et de 
la luminosité de toutes les couleurs du dégradé. 
 
Zones couleurs - Pour choisir la couleur. 
 
Palettes - Différents jeux de couleurs. Vous pouvez 
ajouter des couleurs personnalisées. Elles seront 
sauvegardées pour une prochaine utilisation, même en 
cas de fermeture de l'application. 

 /   - Ajout et suppression de couleurs. 
 
Dégradés - Choisissez le dégradé à utiliser. 

 /   - Ajout et suppression de dégradés. 
 

Pour n'utiliser qu'une seule couleur à la place d'un 
dégradé, définissez le noir comme couleur de début du 
dégradé, la couleur choisie comme couleur intermédiaire    
et le blanc comme couleur de fin. 
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Fenêtre des calques 

 
Utilisez la fenêtre des calques pour les éditer et les 
manipuler. 
 
Blending (Mode de fusion) - Mode de couleur du calque. 
Opacity (Opacité) - Régler l’opacité du calque (0 - 100). 

 - Afficher ou cacher le calque actif. 
Background Color (Couleur de fond) - Afficher/cacher la 
Couleur de fond et sélectionner sa couleur. 

 Importer Image - Importer la seconde image pour 
composition.  

 Effacer Calque - Effacer le calque Amberlight ou 
Image. 
 

 

Fenêtre Base de temps 
 
Utilisez cette fenêtre pour créer une animation ou éditer et manipuler des images et des clefs. 
 

 
 
Playback Range Start Time (Début de l'intervalle) - Définit la position de démarrage de la 
séquence. Vous pouvez la modifier en entrant une nouvelle valeur. Si vous entrez une valeur 
supérieure à la valeur de fin, une valeur égale à "valeur de fin moins un" sera assignée. 
Playback Range End Time (Fin de l'intervalle) - Définit la valeur de fin de la séquence. Vous 
pouvez la modifier en entrant une nouvelle valeur. Si vous entrez une valeur inférieure à la 
valeur de début, une valeur égale à "valeur de début plus un" sera assignée.  
Animation Start Time (Heure de démarrage de l'animation) - Définit le numéro de la première 
image de l'animation. 
Animation End Time (Heure de fin de l'animation) - Définit le numéro de la dernière image de 
l'animation. 
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Current Frame (Image en cours) -La valeur du champ indique la position de l'image en cours. 
Vous pouvez la modifier en entrant une nouvelle valeur. 
Range Slider (Curseur d'étendue) -Définit la partie d'animation à exécuter. 
Time Slider (Curseur de temps) - Contrôle l'étendue d'animation à exécuter, ainsi que les clefs 
et les sélections associées.  
Rendered Range (Etendue effectuée) - Une ligne verte indique les images qui ont déjà été 
traitées par la fonction 'génération d'animation'. 
Selection - Sélection multiple de clés à couper, copier, coller ou supprimer. 
 
Contrôles d'exécution de l'animation : 

 Go to Start (Aller au début) - Se positionner au début de la séquence à exécuter. 

 Previous Keyframe (Clef précédente) - Se positionner sur la clef précédente. 

 Previous Frame (Image précédente) - Se positionner sur l'image précédente. 

 Play (Exécuter) - Exécuter l'animation. Lorsqu'elle s'exécute, ce bouton se transforme en 

bouton d'arrêt   

 Next Frame (Image suivante) - Se positionner sur l'image suivante. 

 Next Keyframe (Clef suivante) - Se positionner sur la clef suivante. 

 Go to End (Aller à la fin) - Se positionner à la fin de la séquence à exécuter. 
 

 Add Keyframe (Ajout d'une clef) - Ajout d'une nouvelle clef. 

 Remove Keyframe (Suppression d'une clef) - Suppression d'une ou plusieurs clefs. 
Auto Key (Clef automatique) - Création automatique d'une clef. Une clef sera 
automatiquement créée pour l'image actuelle. Décochez si vous souhaitez créer les clefs 
manuellement. 
All Fields (Tous les champs) - Des clefs seront créées pour tous les champs. Décochez cette 
option si vous ne voulez créer une clef que pour un seul champ. 

 Scene Settings (Paramètres de scène) - Ouverture de la fenêtre de dialogue des Paramètres 
de scène. 
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Edition des champs 
Appuyez sur le bouton Editer dans la fenêtre Scène ou cliquez avec le bouton gauche sur la 
scène pour éditer les champs. Vous pouvez régler le nombre de champs de 1 à 12 dans la 
fenêtre Scène. Chaque champ est représenté par un cercle ayant une position et 3 paramètres. 
Vous pouvez utiliser ceux-ci pour régler la manière dont le champ influencera les particules. 
 
 

Paramètres du champ 
 

Position du centre - (A) - Cliquez avec le bouton 
gauche sur le centre du cercle pour régler la 
position du champ sur la scène. 
 
Force - (B) - Cliquez avec le bouton gauche pour 
régler la force du champ en le déplaçant de gauche 
à droite. Vers la droite, vous donnez une force 
positive (+) alors que vers la gauche elle sera 
négative (-). 
 
Intensité - (C) - Cliquez avec le bouton gauche pour 
régler l’intensité du champ en le déplaçant de haut 
en bas. La distance par rapport au centre donne 
l’intensité d’influence du champ sur les particules. 
Au-dessus du centre, elle est plus grande et au-
dessous, plus petite. 
 
Limite d'action - (D) - Cliquez sur un bouton et 
réglez la limite d'action du champ en le déplaçant 
en dessous du centre du cercle. La distance par 
rapport au centre du cercle définit la distance où 
les particules sortiront du champ. 
Pressez Ctrl / Cmd en mode Edition pour déplacer, 
zoomer ou faire tourner tous les champs. Vous 
trouverez plus d’information dans le chapitre 
Raccourcis. 
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Travailler avec les champs 
 
Pour copier les propriétés du champ sélectionné, utilisez Ctrl + C / Cmd + C ou Edit -> Copy 
Field Properties. 
Pour coller les propriétés dans un champ, utilisez Ctrl + V / Cmd + V ou Edit -> Paste Field 
Properties. 
Pour dupliquer un ou plusieurs champs sélectionnés, utilisez Ctrl +D / Cmd + D ou Edit -> 
Duplicate Fields. 
Sélectionnez tous les champs avec Ctrl + A / Cmd +A ou Edit -> Select All Fields.  
Vous pouvez également sélectionner les champs en cliquant et tirant pour déplacer, 
redimensionner ou faire tourner les champs.  
Utilisez Maj pour agrandir un groupe de champs et Ctrl / Cmd pour le faire tourner. 
Le centre de la rotation est identifié par le symbole ( + ). Vous pouvez le déplacer n'importe où 
en cliquant et en le tirant à la position souhaitée. 
 

 
 

View grids (Afficher la grille) pour positionner précisément les champs avec la commande 
Scene -> Snap to Grid (Scène -> Magnétisme). Le centre du champ, le centre de la sélection et 
les clefs sont collées à la grille. 
Vous pouvez définir le pas de la grille dans la fenêtre Préférences. 
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Barre de Menus 
 
File (Fichier) - Contient les éléments relatifs à l’ouverture, l’enregistrement, l’exportation et la 
publication de vos œuvres. 
Edit (Editer) - Contient les éléments relatifs à l'édition et aux champs. 
Scene (Scène) - Contient les éléments relatifs aux outils d’édition ainsi qu’au canevas. 
Filter (Filtre) - Contient les éléments relatifs aux filtres de l’image. 
View (Vue) - Contient les éléments relatifs à l’affichage ainsi qu’à l’interface. 
Window (Fenêtre) - Contient les éléments relatifs à l’interface utilisateur. 
Help (Aide) - Contient les éléments qui vous permettent d’avoir de l’aide pour l’application, ou 
rechercher des mises-à-jour sur le site web. 
 
 

Menu File (Fichier)  
 
Le menu Fichier contient les éléments permettant de gérer votre image : 
 
New... (Nouveau) - Ouverture d'une boîte de dialogue vous permettant de créer une nouvelle 
image avec tous ses paramètres. 
Vous pouvez d définir la largeur et la hauteur de la nouvelle image (en pixels, centimètres ou 
pouces), définir la vitesse d'animation en images par seconde (FPS), définir une boucle de 
lecture, la couleur d'arrière-plan et la résolution en points par pouce (DPI)  
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Vous pouvez également choisir l'un des formats prédéfinis, supprimer des formats ou ajouter 

les vôtres en utilisant les boutons   ou    
. 
Open... (Ouvrir) - Ouvrir une image depuis un support externe. 
Open recent…  (Ouvrir récent) - Ouvrir l'une des images sur lesquelles vous avez travaillé 
récemment.  
Save... (Sauvegarder) - Sauvegarder votre image dans l'un des formats .amb, .png, .jpg, .bmp 
ou  .tif. Si vous ne l'avez pas encore sauvegardée, vous devrez lui donner un nom. 
Save As… (Sauvegarder sous) - Sauvegarder une copie de votre image avec un nouveau nom. 
 
Import Image...(Importer image)  - Importer une image au format  .png, .jpg, .bmp ou .tif dans 
un calque. L'image importée est redimensionnée pour s'adapter à la taille de l'image sur 
laquelle vous travaillez, mais vous pourrez ensuite modifier sa taille. Cliquez sur Entrée pour 
confirmer ou Echap. Pour annuler. 
Export Image… (Exporter image) - Exporter l'image en cours au format .png, .jpg, .bmp, ou .tif. 
 
Publish Image... (Publier image) - Publier votre image dans la galerie d'Escape Motions. 
Publish Preferences...  (Préférences de publication) - Définissez votre nom, votre adresse e-mail 
(votre "ID") et votre mot de passe pour accéder ensuite à la galerie. Vous pouvez 
éventuellement entrer un lien vers votre site Internet. 
 
Pour plus d'information, consultez le chapitre "Publication d'une image dans la galerie" 
 
Preferences… (Préférences) - Définit les préférences générales et celles du clavier (raccourcis). 
- General (Général)  
- Startup Screen (Ecran de démarrage) - Si cette case est cochée, une fenêtre de dialogue “New 
Scene” (Nouvelle image) est affichée à chaque lancement de l'application Amberlight. 
- Scene - Zoom at cursor (Zoom sur le curseur). Si cette case est cochée, le centre du zoom sera 
la position du curseur. Sinon, ce sera le centre de la scène. 
- Jpeg compression (Compression Jpeg) - Définit la qualité des fichiers Jpeg.  
- Interface - Définit l'échelle à laquelle redimensionner l'interface (90-200%). 
- Spinbox editing sensitivity - Définit la sensibilité pour la souris ou la tablette. 
- Memory (Mémoire) - Définit la taille de mémoire maximale à utiliser. 
- Grid (Grille) - Définit le nombre de divisions horizontales et verticales de la grille (maximum 
100). 
- Keyboard (Clavier) - Définit les raccourcis clavier personnalisés. Cliquez sur Reset pour 
réinitialiser le raccourci en cours ou sur Delete pour le supprimer. Cliquez sur Reset All pour 
réinitialiser tous les raccourcis. 
 
Cliquez sur OK pour continuer ou sur Cancel si vous ne le souhaitez pas. 
 
Quit (Quitter) - Pour terminer l'application. (Uniquement sous Windows) 
 
Pour plus d'information sur la création, l'ouverture et la sauvegarde de vos images, consultez le 
chapitre "  
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Création, chargement et enregistrement d’images" plus loin dans ce manuel. 
 
Astuce : Vous pouvez également "tirer" une image de n'importe quelle application, du 
gestionnaire de fichiers ou du navigateur Internet dans Amberlight, si l'application autorise 
cette opération. 
 

Menu Edit (Editer) 
 

Undo (Annuler) - Annule la dernière opération que vous avez effectuée. Le nombre maximum 
d'annulations est de 100. 
Redo (Rétablir) - Rétablit la dernière opération que vous avez annulée. 
 
Copy Field Properties (Copier les propriétés du champ) - Copie les propriétés du champ 
sélectionné. 
Paste Field Properties (Coller les propriétés du champ) - Colle les propriétés sur le champ 
sélectionné. 
Duplicate Fields (Dupliquer les champs) - Duplique le(s) champ(s) sélectionné(s). 
Select All Fields (Sélectionner tous les champs) - Sélectionne tous les champs. 
 

Menu Scène 

 
Scene Settings…  (Paramètres de scène) - Ouverture d'une boîte de dialogue vous permettant 
de définir la taille de la scène. Vous pouvez indiquer si vous souhaitez conserver les proportions 
(Keep aspect ratio) de la scène et si vous voulez redimensionner les champs (Scale fields). 
 
Edit (Editer) - Modification des champs : position et paramètres : force, intensité et limite 
d'action. 
Edit Trajectory (Editer la trajectoire) - Définit les points de contrôle et la trajectoire. Chaque 
point de contrôle possède deux tangentes : une gauche et une droite. La modification de ces 
tangentes entraîne la modification de la trajectoire de l'animation. 
Reset Tangents (Réinitialiser les tangentes) - Réinitialise les tangentes à leurs positions par 
défaut. 
Random (Aléatoire) - Définition aléatoire de la scène et des paramètres des champs. 
Snap to Grid (Magnétisme)- Utiliser la grille pour définir plus précisément la position des 
champs. Vous pouvez définir le nombre de divisions de la grille dans la fenêtre Préférences. 
Crop (Recadrage) - Sélectionnez la zone que vous voulez extraire. La zone sélectionnée sera 
replacée dans la scène et les champs seront automatiquement redimensionnés. 
 
Render Image (Génération de l'image) - Génération de l'image actuelle. 
Render Animation (Génération de l'animation) - Génération de l'animation afin de pré-
visualiser le résultat final. 
 
Final Render (Génération finale) - Génération de l'animation et sauvegarde sur l'ordinateur. 
Définissez le chemin d'accès, le nom de fichier et le format de sauvegarde : soit une séquence 
d'images (.jpg, .png, .bmp, .tif), soit une vidéo ( .mov ou .mkv).  
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Menu Filter (Filtres) 
 
Tint (Teinte)- Active / Désactive le filtre Teinte. Définit la couleur, l'angle et l'intensité. 
Glow (Eclat) - Active / Désactive le filtre Eclat. Définit le rayon et l'intensité. 
Tile (Empilement) - Définit la manière dont les calques sont empilés : horizontalement ou 
verticalement. 
 

Menu View (Affichage) 
 
Zoom In (Zoom avant) - Agrandit la scène (maximum 2000%). 
Zoom Out (Zoom arrière) - Réduit la scène (minimum 5%). 
Zoom 100% - Définit le rapport de zoom. En cliquant sur le bouton, l'affichage revient à 100%. 
Fit to Screen (Taille écran) - Ajuste la scène à la taille de la fenêtre de visualisation. 
 

Stay on Top (Toujours au dessus) - Amberlight sera toujours affiché au dessus des autres 
applications. 
Enter Full Screen (Mode plein écran) - Affichage en mode plein écran. 
 

Menu Window (Fenêtres) 
 
Le menu Window (Fenêtres) contient les éléments relatifs aux différentes fenêtres et à 
l'interface utilisateur. 
 
Scene - Affiche ou cache la fenêtre Scene. 
Parameters (Paramètres) - Affiche ou cache la fenêtre Paramètres. 
Modifiers (Modificateurs) - Affiche ou cache la fenêtre des modificateurs.  
Contrast Curve (Courbe de contraste) - Affiche ou cache la fenêtre de la courbe de contraste. 
Filter (Filtres) - Affiche ou cache la fenêtre des filtres. 
Navigator (Navigation) - Affiche ou cache la fenêtre Navigation. 
Palette (Palettes) - Affiche ou ache la fenêtre Palette. 
Layers (Calques) - Affiche ou cache la fenêtre Calques. 
Timeline (Base de temps) - Affiche ou cache la base de temps. 
 
Décochez le nom de la fenêtre pour la supprimer de l'interface utilisateur. Cochez-le pour 
rendre la fenêtre visible. 
 

Menu Help (Aide) 
 
Help (Aide) - Ouvre le présent document. 
Send Feedback...  (Envoi de commentaire) - Pour nous envoyer un message si vous avez 
rencontré un problème, si vous avez une idée d'amélioration ou simplement pour nous dire 
que vous aimez le logiciel. Vous pouvez choisir entre trois types de message : 
Bravo - Souhaitez-vous nous dire que vous aimez ce logiciel ?  
Idea (Suggestion)- Avez-vous une suggestion pour améliorer Amberlight ?  
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Bug (Erreur) - Avez-vous constaté un mauvais fonctionnement d'Amberlight? 
 
Il vous suffit d'entrer votre adresse e-mail et vos commentaires - nous vous promettons de lire 
chaque message qui nous est adressé. ☺ 
 
Amberlight Website (Site Internet Amberlight) - Lien direct vers le site : 
http://amberlight.escapemotions.com. 
Intro Tutorial (Tutoriel) - Affichage du tutoriel d'introduction qui vous guidera à travers les 
principaux outils d'Amberlight. 
About Amberlight (A propos d'Amberlight) - Affichage des informations de base sur 
Amberlight, copyright et crédits. (dans le menu d'aide, uniquement sous  Windows). 
Show Library Folder (Afficher bibliothèque fichiers) - Affiche le répertoire où les dégradés sont 
sauvegardés. 
  

http://amberlight.escapemotions.com/
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Animation 
Ce chapitre explique comment créer une animation avec Amberlight. 
 

1. Création d'une nouvelle scène 
2. Définition de la vitesse d'exécution et de l'exécution en boucle 
3. Utilisation de la base de temps 
4. Animation des champs (exemple simple) 
5. Expérience avec les modificateurs 
6. Prévisualisation de l'animation 
7. Rendu final 

 

1. Création d'une nouvelle scène 
 
Nous allons maintenant voir comment créer une nouvelle scène 
 
1. Cliquez sur File -> New…  (Fichier -> Nouveau) : une fenêtre de définition de scène est 
affichée : 
 

 
 

2. Définissez la largeur, la hauteur et la résolution (DPI) de la scène ou sélectionnez un format 
prédéfini. 
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3. Définissez la vitesse d'exécution en images par seconde (Frames Per Second) et activez ou 
désactivez la possibilité d'exécution en boucle. (Vous trouverez plus d'explication dans la suite 
de ce chapitre). 
 
4. Sauvegardez les caractéristiques de cette scène pour une utilisation future avec le bouton 

 . 
 
5. Définissez la couleur d'arrière-plan. Choisissez soit Noir, soit Blanc, soit Transparent (None) 
ou sélectionnez une couleur particulière dans la palette de couleurs système. 
 
6. Cliquez OK pour continuer ou Cancel pour annuler. 
 
Vous pouvez modifier ces paramètres à n'importe quel moment avec le menu Scene -> Scene 
settings (Scène -> Paramètres de la scène) ou directement dans la base de temps en cliquant 

sur le bouton Scene Settings (Paramètres de la scène) . 
 

 

2. Vitesse d'exécution et exécution en boucle 
 

Lorsque vous créez une nouvelle scène, vous pouvez très facilement définir le nombre d'images 
par seconde (FPS) et l'exécution en boucle. Le nombre d'images par seconde indique combien 
d'images devront être générées pour chaque seconde d'animation. Cet élément est essentiel 
pour déterminer la longueur de l'animation. La valeur recommandée est comprise entre 25 et 
30, mais dépend de l'utilisation que vous ferez de l'animation. Activez l'animation en boucle si 
vous souhaitez que l'animation s'exécute de façon continue.  
Vous pouvez modifier ces options avant d'exécuter le rendu final. 
 

 

Astuce : Pour déterminer le nombre d'images dont vous avez besoin pour votre vidéo, imaginez 
la durée finale en nombre d'images. Si la vitesse d'exécution est de 30 images par seconde et que 
vous voulez une vidéo de 30 secondes, vous devrez créer 900 images ((30 FPS x 30 secondes). 
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3. Utilisation de la base de temps 
 

Utilisez la base de temps pour créer une animation, éditer et / ou manipuler des images et des 
clefs. 
 

 
 
Définissez le nombre d'images en spécifiant les valeurs de Animation Start Time (Début 
d'animation) et de Animation End Time (Fin d'animation). 
Entrez la valeur de Playback Range Start Time (Début d'exécution de l'animation) et de 
Playback Range End Time (Fin d'exécution de l'animation). Cliquez et tirez sur Range Slider 
(Curseur d'étendue) pour vous déplacer dans la base de temps. Le curseur Time Slider (Curseur 
de temps) affiche l'étendue de l'exécution de l'animation et les clefs que vous avez définies.  
Les boutons Playback Controls (Contrôles d'animation) vous permettent de contrôler 
l'exécution de l'animation. Vous reconnaîtrez les boutons habituels pour la lecture et le 
rembobinage (retour au début). Le bouton Arrêt ne s'affiche que lorsque l'animation est en 
cours d'exécution. Pour savoir quelle opération est associée à chaque bouton, il vous suffit d'y 
placer le curseur de la souris :  
 
Contrôles d'exécution de l'animation : 

 Go to Start (Aller au début) - Se positionner au début de la séquence à exécuter. 

 Previous Keyframe (Clef précédente) - Se positionner sur la clef précédente. 

 Previous Frame (Image précédente) - Se positionner sur l'image précédente. 

 Play (Exécuter) - Exécuter l'animation. Lorsqu'elle s'exécute, ce bouton se transforme en 

bouton d'arrêt   

 Next Frame (Image suivante) - Se positionner sur l'image suivante. 

 Next Keyframe (Clef suivante) - Se positionner sur la clef suivante. 

 Go to End (Aller à la fin) - Se positionner à la fin de la séquence à exécuter. 
 

 Add Keyframe (Ajout d'une clef) - Ajout d'une nouvelle clef. 

 Remove Keyframe (Suppression d'une clef) - Suppression d'une ou plusieurs clefs. 
Auto Key (Clefs automatiques) - Création automatique de clefs. Une clef sera 
automatiquement créée à partir de l'image actuelle. Décochez si vous souhaitez créer les clefs 
manuellement. 
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All Fields (Tous les champs) - Une clef sera créée pour tous les champs. Décochez si vous ne 
voulez en créer que pour un seul champ. 

 Scene Settings (Paramètres de scène) - Ouverture de la fenêtre de dialogue des paramètres 
de scène. 
 

Vous pouvez manipuler directement une ou 
plusieurs clefs dans la base de temps. 
Déplacez une clef en utilisant le "cliquer-tirer". 
Sélectionnez plusieurs clefs de la même façon ou 
en utilisant la touché Maj. 
Déplacez-les ou cliquez sur le bouton droit de la 
souris et choisissez Copy (Copier), Cut (Couper), 
Paste (Coller) ou Delete (Supprimer). 
 

 
 
 

4. Animation des champs (exemple simple) 
 

Voici un exemple de création d'une animation simple. Nous utiliserons deux champs. 
 
1. Définissez la position de départ des champs. 
Le nombre de champs par défaut est 4. Ajoutez 

ou supprimez des champs avec les boutons  / 

 dans la Fenêtre Scene ou entrez le nombre 
de champs dans la partie appropriée. Pour 
éditer les champs, vous pouvez soit cliquer sur le 
bouton Edit de la Fenêtre Scene, ou cliquez 
directement dans la scène avec le bouton 
gauche de la souris. Vous pouvez ajouter ou 
supprimer des champs à n'importe quel 
moment. Plus d'information dans la partie 
Edition des champs.  

 
2. Déplacez-vous sur l'image 8 de la base de 
temps. 
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3. Sélectionnez tous les champs avec Ctrl + A ou 
en utilisant la sélection multiple (cliquer et tirer).  
Déplacez les champs à la position souhaitée.  
Comme l'option "Auto Key" (Clef automatique) 
est active, une clef sera automatiquement créée 
en position 8. 
 
 
 
 

 
4. Déplacez-vous sur l'image 15 de la base de 
temps. 
 
 
 
 
 
 
 
 
 

 
5. Cliquez sur le Champ 1 et déplacez-le à la 
position souhaitée.  
Une clef sera automatiquement créée pour ce 
champ en position 15. 
 
 
 
 
 
 
 

 
6. Cliquez sur le Champ 2 et déplacez-le à la 
position souhaitée. 
Une clef sera automatiquement créée en 
position 15. 
 
 

 

 

 

 

 

Pour visualiser la trajectoire suivie par une animation, cliquez au centre du champ. 
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Les points de référence de la trajectoire sont affichés comme des nœuds. Vous pouvez 
manipuler la position de ces points de référence directement sur la courbe. 
 
Pour éditer les points de référence ou la trajectoire de l'animation, allez sur la commande 
“Scene” -> “Edit trajectory” (Scène -> Edition de trajectoire). Les tangentes de chaque point de 
référence sont affichées. Chaque point de référence a deux tangentes, une à droite, une à 
gauche. En déplaçant ces tangentes, vous pouvez modifier la forme de la trajectoire : 
 

 
 

Pour réinitialiser la position des tangentes, utilisez la commande "Scene” -> “Reset tangents” 
(Scène -> Réinitialiser les tangentes". 
 
 

5. Expérience avec les modificateurs 
 

Les modificateurs vous permettent de changer la forme et l'aspect final de la scène. Ils se 
divisent en deux groupes : Variations et Ondes. 
 
Variations 
 
Vous pouvez choisir entre deux types de variations : 
 
Random (Aléatoire) - Les champs généreront des formes et des groupements aléatoires. 
Uniform (Uniforme) - Les champs généreront des formes et des groupements uniformes. 
 
Vous pouvez sélectionner le Nombre (Number) de variations qui influeront sur le nombre de 
variations créées dans la scène. Vous pouvez également définir le pas des variations : le 
paramètre Scale détermine la position de chaque variation : lorsque cette valeur est faible, les 
variations seront très proches les unes des autres, quand cette valeur est élevée, la distance 
entre les variations sera plus grande. 
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Exemples de variations aléatoire et uniforme : 

 
 

Onde 

 

Vous pouvez choisir parmi cinq types d'ondes :  
 
None (Aucune) - Pas d'onde utilisée. 
Circle (Circulaire) - Onde circulaire. 
Square (Carrée) - Onde carrée. 
Vertical (Verticale) - Onde verticale. 
Horizontal (Horizontale) - Onde horizontale. 
 
Exemples d'ondes modificatrices : 

 
 
Vous pouvez définir la Fréquence (Frequency) des ondes: vitesse à la quelle les ondes se 
propagent sur la scène. Vous choisirez la force des ondes avec le curseur Amplitude. 
L'amplitude représente la moitié de la distance entre les valeurs minimale et maximale de 
l'onde. 
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Exemples d'onde carrée avec différentes valeurs de fréquence et d'amplitude : 

 

 
6. Prévisualisation de l'animation 

 
Pour vérifier comment l'animation se déroulera, vous pouvez utilisez le bouton Render (Rendu) 
dans la fenêtre Scene. Mais vous n'êtes pas obligé de le faire avant de lancer le rendu final. La 
prévisualisation de l'animation ne sert qu'à vous donner un aperçu du résultat final.  
Lorsque le paramètre Raster a une valeur de 1, le rendu sera plus fin, l'image de meilleure 
qualité mais cela prendra plus de temps pour le calcul et la génération de l'animation. Si vous 
donnez à Raster la valeur 8, vous gagnerez du temps, mais le rendu sera de moins bonne 
qualité. 
Les images e l'animation qui ont déjà été calculées dans la prévisualisation sont marquées en 
vert dans la base de temps. 
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Note: Le calcul de rendu est un travail  nécessitant de nombreuses opérations sur l'ordinateur. 

Lorsque vous avez de nombreuses clefs et d'images cela demandera beaucoup de temps. Nous 

vous conseillons de donner une valeur élevée pour avoir une approximation rapide du rendu final. 

La qualité de la prévisualisation est indépendante de la qualité du rendu final. 

 

 

7. Rendu final 
 

Lorsque vous êtes satisfait avec l'animation, rendez-vous dans le menu Scene -> Final render 
(Scene -> Rendu final). 
Choisissez le chemin d'accès, le nom du fichier et son format - soit une séquence d'images en 
format  .jpg, .png, .bmp, .tif ou une vidéo au format .avi, mov, .mkv ou .webm. 
 
 

Pour une séquence d'images, définissez le 
remplissage et l'extension de l'animation.  
 
Choisissez l'image de départ, l'image de fin et le 
nombre d'étapes du calcul de rendu. 
Cliquez sur Render (Rendu) pour lancer le calcul du 
rendu final ou sur Cancel pour arrêter. 
Cliquez sur Apply (Appliquer) pour appliquer les 
modifications. 
 
Vous pouvez créer une animation et l'utiliser 
ensuite dans d'autres applications. 
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Pour créer une vidéo, définissez la vitesse (en 
images par seconde - FPS). Sélectionnez le codec 
approprié : 
.avi: h264, huffYUV (compression sans perte) 
.mov: h264, h265 
.mkv: h264, h265, huffYUV ( compression sans 
perte) 
.webm: VP8 
 
Choisissez la qualité "de base" ou "haute qualité"  
Basic (de base) - définit la qualité en %. Plus cette 
valeur est élevée, plus le fichier sera volumineux. 
Advanced (haute qualité) - définit les paramètres 
avancés pour le codec sélectionné : profil, niveau, 
taux de transfert, taux de transfert maximum et 
intervalle entre clefs.  
Choisissez compression sans perte si vous voulez 
que l'original et la vidéo décompressée soient 
identiques. La compression sans perte n'est pas 
disponible pour le codec VP8. 
Ces réglages sont pour les utilisateurs 
expérimentés familiarisés avec les codecs H.264, 
H.265 et VP8. 
 

 
 
 
Choisissez les images de début et de fin, ainsi que le nombre d'étapes utilisées dans le rendu. 
Cliquez sur Render (Rendu) pour lancer l'opération ou sur Cancel pour annuler. 
Cliquez sur Apply pour appliquer les modifications. 
 
Quand le calcul du rendu final commence, l'application affiche le temps estimé de l'opération :  
 

 
 

Note: Plus vous demanderez d'étapes pour le rendu final, plus l'opération sera longue. Des 

animations importantes peuvent nécessiter plusieurs heures de calcul. Nous vous recommandons 

de les lancer quand vous n'utilisez pas l'ordinateur de façon intensive, par exemple durant la nuit.  
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Création, chargement et enregistrement d’images 
 

Création d’une nouvelle scène 
 

Pour créer une nouvelle scène, sélectionnez l’option New (Nouveau) du menu File (Fichiers). La 
boîte de dialogue New scene (Nouvelle scène) apparaît. Elle vous permet de définir la taille de 
votre nouvelle scène ainsi que les paramètres que vous allez utiliser. Dans la section “Image 
size info" (Info sur la taille de l’image) vous pouvez contrôler la résolution de l’impression en 
DPI. 
 

Vous pouvez sélectionner la couleur de l’arrière-plan en sélectionnant Custom (Personnalisé) 
dans le menu déroulant Background color. Vous avez aussi le choix des préréglages de fond 
Black (Noir), White (Blanc) ou None (Transparent).  
 

Finalement, cliquez OK pour créer une nouvelle scène ou Cancel (Annuler) si vous en décidez 
ainsi. 
 

Ouverture d’une scène 
 

Pour ouvrir une scène, sélectionnez l’option Open du menu File. Cette boîte de dialogue vous 
permet d’ouvrir une image (PNG, JPG, BMP, TIFF) ou une œuvre précédemment enregistrée 
(au format de fichier AMB) et de régler les propriétés. En ouvrant une œuvre sauvegardée, 
l’image va être rendue à nouveau. 
 

Finalement, cliquez OK pour ouvrir la scène, ou Cancel (Annuler) si vous renoncez à l’ouvrir. 
 

Vous pouvez aussi Glisser-Déposer une image directement depuis n’importe quelle source - 
dossier, navigateur ou site web - et elle sera ouverte dans le calque « Image ». 
 

Enregistrement d’une scène 
 

Pour sauvegarder votre scène, utiliser l’option Save du menu File. Le format natif est au format 
AMB, qui contient toutes les informations sur votre œuvre et sur les calques. Utilisez ce format 
si vous voulez poursuivre la scène plus tard. En ré-ouvrant une œuvre sauvegardée, l’image va 
être rendue à nouveau. 
 
Vous pouvez aussi choisir un format de fichier différent, mais ceux-ci ne peuvent pas contenir 
toutes les informations sur votre création et peuvent ne pas être ouverts correctement (la 
couleur de fond peut être différente ou la transparence pourrait ne pas être enregistrée dans 
le format JPEG).  
 
Si vous désirez enregistrer votre scène avec des réglages particuliers ou dans un format qui 
puisse être lu par d’autres applications, utilisez l’option Save as (Enregistrer sous) du menu File. 
Cela vous permet d’enregistrer votre scène au format PNG, JPEG, BMP ou TIFF.  
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Finalement, cliquez OK pour enregistrer la scène ou Cancel (Annuler). 
 
 

Fermeture de l'application  
 
Si vous souhaitez fermer l'application, vous avez plusieurs possibilités selon votre système d'exploitation 

 

Utilisateur Windows 

- cliquer sur le menu File -> Quit, ou  

- cliquer sur le bouton Fermer dans le coin 

supérieur droit de l'application ou 

- utiliser un raccourci Ctrl+W ou Alt+F4 

 

Utilisateur Mac OS 

- cliquer sur le menu Quit, ou 

- cliquez sur le bouton Quitter dans le coin 

supérieur gauche de l'application ou 

- utiliser le raccourci Cmd-Q  

 

 
Note: N'oubliez pas de sauvegarder votre travail avant de fermer l'application 
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Publier une scène dans la Gallery 
 

Création d’un compte Gallery 
 
Pour publier vos œuvres, vous devez premièrement créer un compte. Vous avez deux options 
pour créer un compte:  
 
Depuis l’application: 
Créez votre compte Gallery depuis le menu File -> Publish Preferences (Fichier->Préférences de 
publication). Entrez votre nom, E-mail ("Votre ID") et mot de passe et, si vous le désirez, un lien 
vers votre site web. 
 
Depuis le site web: 
Sur la page Gallery, cliquez login -> Create account (login -> Créer un compte) et entrez “Votre 
ID” (E-mail pour l’enregistrement). Vous recevrez un mot de passe que vous pourrez changer 
par la suite. 
Note: Vous trouverez "Votre ID" dans le menu Help -> About Flame Painter (Aide->A propos de 
Flame Painter). Si "Votre ID" n’existe pas, entrez votre E-mail actif. 
 
 

Publier une œuvre de Amberlight vers Gallery 
 
Pour publier vos œuvres, utilisez l’option Publish (Publier) dans le menu File. Entrez un Nom 
pour votre œuvre, une Description et des Tags pour votre image. Cliquez sur le bouton Publier. 
Votre image sera publiée sur la Gallery (www.escapemotions.com/gallery) ou vous pouvez 
éditer les images par la suite. 
 
 

Editer votre profil et vos œuvres dans Gallery 
 
Si vous avez déjà créé un compte, allez sur la page web de Gallery, cliquez login et entrez 
"Votre ID" et mot de passe. 
Dans la section Editer des images, vous pouvez éditer le nom, la description, les tags et 
d’autres paramètres de vos créations. 
Dans la section My Profile (Mon profil), vous pouvez changer votre mot de passe. 
 
 

Note: Seules des images fixes peuvent être ajoutées à notre galerie. Pour partager une vidéo, téléchargez-

la sur un site de partage de vidéos tel que Youtube ou Vimeo. 

 
  

http://www.escapemotions.com/gallery
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Raccourcis clavier 
 
 Windows Mac OS 

Nouveau...  Ctrl-N Cmd-N 

Ouvrir... Ctrl-O Cmd-O 

Enregistrer Ctrl-S Cmd-S 

Enregistrer sous... Ctrl-Maj-S Cmd-Maj-S 

Quitter Ctrl-W Cmd-Q 

 

Taille… Ctrl-E Cmd-E 

 

Mode édition E E 

Editer tous les champs Ctrl Cmd 
en mode édition 

Déplacer les champs Ctrl + Clic-droit Cmd + Clic-droit 
en mode Edition 

Zoomer sur les champs Ctrl / Cmd + Roulette de souris ou Clic-gauche 
en mode Edition 

Tourner les champs Ctrl + Clic-gauche Cmd + Clic-gauche 
en mode Edition 

 

Augmenter la valeur +1 Up Up 

Diminuer la valeur -1 Down Down 

Augmenter la valeur +10 Pg Up Pg Up 

Diminuer la valeur -10 Pg Down Pg Down 

 

Déplacer un canevas Clic droit ou Barre d’espace + Clic gauche 

 

Zoom avant Ctrl - + Cmd - + 

Zoom arrière Ctrl - - Cmd - - 

Zoom 100% Ctrl - 0 Cmd - 0 

Zoom avant | arrière Roulette de souris ou Alt + Roulette de souris 

 

Aide F1 Cmd + ? 
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Copyright & Crédits 
 
 
Amberlight© 2013-2016 Escape Motions, s.r.o 
Amberlight © 2009-2012 Peter Blaškovič 
 
 

Team Amberlight: 
 
Peter Blaškovič, Michal Fapšo, Ľuboš Tóth, Miroslav Sedlák, Anton Poživenec, Veronika 
Klimeková, Andrea Hornáková, Jaroslav Kaša 
 
 

Remerciements particuliers à : 
 
Tous ceux qui ont contribué par des idées, des suggestions, ou qui ont aidé à finaliser Amberlight, 
particulièrement à Jozef Bardík, Jaroslav Kaša, Daniel Innes, Tomáš Lancz, Harvey Bunda, Devraj 
Baruah, Rana Dias, Nigel Brewster, Jim Kanter, Rastislav Piovarči, Gregorii Trombo.  
Traduction et corrections: Tanya Hayman, Kévin Jorand, Veronika Klimeková, Marta Fernandez, 
Andrea Vachová, Irene Briz, Serge Fleury. 
Icones de l’interface utilisateur: "Batch" by Adam Whitcroft 
 
 

Librairies: 
 
Cette application a été développée avec les librairies suivantes: 
Qt 4.8 - LGPL license (2.1) - http://qt-project.org/downloads/ 

QuaZIP - LGPL license (2.1) - http://sourceforge.net/projects/quazip/ 

CryptoPP - Boost Software License (1.0) - http://www.cryptopp.com/ 
FFmpeg with libx264, libx265 and libvpx - https://www.ffmpeg.org/ 

H.264/AVC license by MPEGLA - http://www.mpegla.com 

H.265/HEVC license by MPEGLA - http://www.mpegla.com 

 

La liste complète des licences utilisées est disponible dans le dossier d'installation : Amberlight2 

/ Licenses 

 
 
Merci à Dieu pour toutes les idées créatives. 
  

http://qt-project.org/downloads
http://sourceforge.net/projects/quazip/
http://www.cryptopp.com/
https://www.ffmpeg.org/
http://www.mpegla.com/
http://www.mpegla.com/
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Amberlight End-User Software License Agreement  
 
Copyright © 2013-2016 Escape Motions, s.r.o. All Rights Reserved. 
Copyright © 2009-2012 Peter Blaškovič. All Rights Reserved. 
 
This license is a legal agreement between you and Escape Motions for the use of Amberlight 
software (the "Software"). By downloading, installing, copying, or otherwise using the Software, 
you acknowledge that you have read terms and conditions of this license, understand them, and 
agree to be bound by them. If you do not agree with these terms and conditions, Escape Motions 
is unwilling to license the Software to you, and you are not authorized and may not use the 
Software. 
 
Permitted Use 
 
You may install the Software on multiple computers provided that not more than one of those 
computers is in use simultaneously and that those computers are solely for your own personal 
use. 
The Software may be installed on a computer that is for multiple users but it may not be installed 
on more than one computer regardless of whether those computers are operated 
simultaneously or not. 
Users may use the Software for commercial or for-profit activities as well as for personal, non-
commercial, or non-profit activities.  
 
You may not remove the copyrights notices from the Software. You may make one (1) copy of 
the Software for back-up or archival purposes. 
 
Restrictions  
 
This is a SINGLE COPY SOFTWARE LICENSE. The Software is copyrighted and protected by law 
and international treaty.  This is a license, not a transfer of title, and unless you have been 
granted prior, written consent from Escape Motions you may not:  
a, Reproduce, distribute, or transfer the Software, or portions thereof, to any third party.  
b, Sell, rent, lease, assign, or sublet the Software or portions thereof.  
c, Grant rights to any other person.  
d, Modify, decompile, reverse engineer, disassemble, or create derivative works based on the 
Software or the documentation in whole or in part.  
e, Use the Software in violation of any international law or regulation.  
 
You must not intentionally or unintentionally make the Software available on any web server, 
ftp server, file sharing network, shared directory, or other location where any other person can 
acquire a copy of the Software. You are responsible for keeping the Software safe from being 
copied by others. 
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Display of Copyright Notices  
 
All copyright and proprietary notices and logos within the Software files must remain intact.  
 
Indemnity  
 
You agree to indemnify and hold harmless Escape Motions for any third-party claims, actions or 
suits, as well as any related expenses, liabilities, damages, settlements or fees arising from your 
use or misuse of the Software, or a violation of any terms of this license.  
 
The Software may contain technical inaccuracies or typographical errors, so changes and/or 
updates may be affected without notice. Escape Motions may also make improvements and/or 
other changes to the Software at any time without notice.   
 
Disclaimer Of Warranty 
 
THE SOFTWARE IS PROVIDED \"AS IS\", WITHOUT WARRANTY OF ANY KIND, EXPRESSED OR 
IMPLIED, AS TO THE SOFTWARE OR ITS OPERATION, INCLUDING, BUT NOT LIMITED TO, 
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE.  FURTHER, PETER BLASKOVIC DOES NOT WARRANT THAT 
THE SOFTWARE OR ANY RELATED SERVICE WILL ALWAYS BE AVAILABLE.  
 
H.264/AVC and H.265/HEVC License Notice 
 
To the extent that the Software contains AVC and HEVC encoding and/or decoding 
functionality, commercial use of AVC and HEVC requires additional licensing and the following 
provision applies: THE AVC AND HEVC FUNCTIONALITY IN THIS PRODUCT IS LICENSED HEREIN 
ONLY FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER TO ENCODE VIDEO IN 
COMPLIANCE WITH THE AVC AND HEVC STANDARD ("AVC VIDEO" / “HEVC VIDEO”) AND/OR 
DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND 
NON-COMMERCIAL ACTIVITY AND/OR AVC AND HEVC VIDEO THAT WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC AND HEVC VIDEO. 
INFORMATION REGARDING OTHER USES AND LICENSES MAY BE OBTAINED FROM MPEG LA L.L.C. 
SEE HTTP://WWW.MPEGLA.COM. 
 
Limitations Of Liability 
 
YOU ASSUME ALL RISK ASSOCIATED WITH THE INSTALLATION AND USE OF THE SOFTWARE. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS OF THE SOFTWARE BE LIABLE FOR 
CLAIMS, DAMAGES OR OTHER LIABILITY ARISING FROM, OUT OF, OR IN CONNECTION WITH THE 
SOFTWARE. LICENSE HOLDERS ARE SOLELY RESPONSIBLE FOR DETERMINING THE 
APPROPRIATENESS OF USE AND ASSUME ALL RISKS ASSOCIATED WITH ITS USE, INCLUDING BUT 
NOT LIMITED TO THE RISKS OF PROGRAM ERRORS, DAMAGE TO EQUIPMENT, ANY LOST 
PROFITS, BUSINESS INTERRUPTION, LOSS OF DATA OR SOFTWARE PROGRAMS, OR 
UNAVAILABILITY OR INTERRUPTION OF OPERATIONS. 


